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WinWeef main screen 
When WinWeef starts, at first a start-up screen is shown with a picture of a draft and the name of the 
owner. This screen remains for 3 seconds. 
The main screen of WinWeef shows the threading, tie-up, treadling and the draft that is built up with it.  
The headline shows ‘WinWeef 10.3 of name of the owner – [Name less]’ 

 After the draft has been saved or when an existing draft is opened, instead of [Name less], the 
name of the file appears. 

 In case the draft was made by someone else, his or her name appears instead of the name of the 
owner of WinWeef. 

 
Below the headline find the menu’s Files, Edit, Color, Display, Settings, Analysis, Techniques, Help.  
All these menus are explained in this Manual. When a menu is opened and browsed through with the 
mouse cursor or arrow keys, a hint is given in the status bar at the bottom of the WinWeef window for a 
longer description of the menu choice. 
 
Below the header is the toolbar with icons of the most frequently used functions. Here too, a hint is always 
displayed in the status bar. As in the menus, the functions which are not relevant, are faded out.  
 
Above the threading and besides the treadling, are scroll bars that can be used when there are more 
threads than can be shown in the window. By moving the scroll bar, another part of the drawdown can be 
seen. 
This can be accomplished 

 by dragging the block back and forth with the mouse cursor pressed.  

 with the mouse wheel. This ensures that in the treadling 7 threads are scrolled further.  

 by clicking next to or above the block: WinWeef then scrolls exactly one screen further, showing the 
last thread of the previous screen as the first thread of the next screen.  

 by clicking on the black arrows of the scroll bars one thread is scrolled further. 
 
A ruler above the threading, besides the treadling and around the tie-up show which thread numbers are 
shown. Numbering, the amount of numbers or omitting numbering can be set in menu Settings - 
Preferences - Thread numbering.  
 
The largest and most important part of the WinWeef window is occupied by threading, tie-up, treadling and 
the drawdown built up from it. The position and color of these parts can be set in menu Settings - 
Preferences. 
 

 
 

The status bar at the bottom of the window can show a text with a hint. In all other cases the status bar is 
divided into five parts. When it says: 

 Threading 28 Shaft 6, it means on which of the squares of the threading, tie-up, treadling, drawdown 
or analysis the mouse cursor is. 

 Block Threading 16 through 28: this shows the size of a block in block mode.  

 Block Mode or Draw Mode. When using Block Mode-tool, the mouse cursor changes into a cross 
with a viewfinder, containing a dot.   

 
 Altered. This tool indicates whether changes were made in the draft after the last time that it was 

opened or saved. WinWeef will ask whether changes in the draft must be saved, also when another 
draft is made, opened or the program is stopped. 

 Threading: this shows the location of the mouse cursor: at threading, tie-up, treadling, drawdown or 
analysis. 
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Color Palette 
The color palette is at the far right in the WinWeef window, indicating all possible colors of 
the design, not necessarily already used for a thread. 
When the mouse cursor is moved over the threads of the threading or treadling, the used 
color is pointed out with a cross in the color palette. 
To prevent that colors that are not used in the design, will also disappear from the color 
palette, a color can be consolidated. A solid color shows a dotted outline.  
 
See Working with colors  

 

Drawing threading, tie-up and treadling 
The main goal of WinWeef is designing a weave by drawing a threading, tie-up and treadling. The sizes of 
the design must be set in the Menu in Settings – Draft. This section discusses how to design. See also the 
shortcut keys. 
 
A square is filled by clicking the mouse cursor on the desired thread of the desired shaft or treadle, or on 
the desired position of a tie-up. Another click removes the drawn square. A drawn square will jump to 
another shaft after a click on that specific one: An end can only be drawn on one shaft.  
In the treadling it is possible; depending on the settings a second click will let the first drawn square jump or 
add a new one. 
If the combination of shafts, tie-up and treadle leads to pull up (or down) a thread, WinWeef draws the color 
of that specific thread in the drawdown. 
When dragging the pushed down mouse over several threads, a trace of squares is drawn. When the 
mouse reaches the window edge, WinWeef automatically 'scrolls', it just continues drawing on the next part 
of the design. 
  

Drawing a straight line can be done in another way: 

 Start clicking on the first square of the line of squares to be drawn. 

 Go, with the mouse to the second square of the line to be drawn, holding 
down the [Shift] and click on that spot.  
WinWeef will draw a line across all intermediate squares. 
When scrolling to another point, a line can be drawn from the second point to this 

new point, and so on. 
 
[Ctrl Alt Click] on a square makes a diagonal, starting at the position of the mouse cursor.  
The diagonal does not necessarily have to be drawn from the front or rear shaft.  
When the front row of shafts is clicked somewhere, the diagonal is drawn from that shaft to the top right of 
the threading. When the rear row of shafts is clicked somewhere, the diagonal from that shaft is drawn to 
the bottom right of the threading.  
 
Drawing the diagonal in the treadling follows the same principle. Clicking anywhere on the left set of 
treadles, the diagonal is drawn from that treadle to the bottom right in the treadling. If anywhere on the 
right-hand set of treadles is clicked, the diagonal from that treadle is drawn to the bottom left in the 
treadling.  
 
In the tie-up it is important to click exactly on the desired square on the outer edge! 
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Clicking in a square in Results in a diagonal from that square to 

Left column, but not in the bottom one Top right 

Right column, but not in the top one Top left 

Lower row, but not in the one on the right Top right 

Top row, but not in the one on the left Bottom left 

Right click menu and draw mode 
In the draw mode a Right Click gives extra options  
 

 Diagonal. ‘Diagonal top right’, ‘Diagonal bottom 
right’, ‘Diagonal top left’, or ‘Diagonal bottom 
left’. This way the direction of the diagonal is 
precisely determined. 

 Draw line. Give a right click in the square 
where the line must end and select the option 
Draw line. 

 Colored End, see Right Click Menu and Color. 

 Move shaft/ treadle forward: is only possible 
via this menu, see for options later on. 

 Move shaft/ treadle back, also only via this 
menu. 

 Move shaft/ treadle to position… Right click on 
a shaft/ treadle, select Shaft/Treadle to 
position...., and then click on the desired 
position.  

 To Clipboard places threading or treadling or 
tie-up or drawdown on the Windows clipboard. 
From there it can be pasted into a Word 
Document, for instance.  
 

 

Moving of a shaft/ treadle to another place: Right click on a shaft/ treadle, then Shaft/ treadle to position…, 
then click on the desired location. 
 
This ‘Shaft/ treadle to position....’ leads to a ‘cut and copy action’, whereby it must be kept in mind that due 
to the cutting action, the treadles to the right of the resulting hole slide one position to the left, so it feels 
that the treadle to be moved does not appear to be on, but to the right of the indicated position. 
When in the example below on treadle 1 is selected for ‘treadle to position…’, and then a click on treadle 
5, is this the result, and of course the tie-up changes with it: 
 

 

 

 
Suppose that in this design the four grey treadles should be placed on the left and the four black ones to 
the right, then of course with grey treadle 2 ‘treadle to the left’ can be chosen. This can be done twice on 
the next grey treadle, on the next grey treadle three times and on the last grey treadle four times, but that 
asks for 10 actions. 
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‘Treadle to position....’, moving from right to left, prevents being bothered by the changes caused by the 
effect of cutting. With the grey treadles, always choose ‘treadle to position....’ via a right mouse click for 
‘treadle to position....’ and then click on treadle 1, 2, 3 or 4 as destination: 
 

    
 
Note. The same goes for the threading. In that case read shaft where it says treadle, read rear where it 
says right, and front for left. 
 
In the tie-up both shafts and treadles can be shifted, taking along the corresponding in the threading or 
treadling.   
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Menu File 
This menu contains options to open, save, print and find drafts. 

New draft 
Opens an empty design window. If the previous draft has not yet been saved, a message appears:  
Do you want to save the Changes?  

 Yes: the changes are saved, see Save as  

 No: the draft is not saved and the changes are lost  

 Cancel: no new draft is created.  
 
For the new design, the number of shafts, treadles, ends and picks, the type of tie-up and the type of 
treadling, and the color representation of the last draft are used. 

Open draft 
Opens an existing WinWeef draft. If the previous draft has not yet been saved, a message appears: Do 
you want to save the Changes? See New draft  
 
Select a draft and click Open or double-click the draft to open it.  
Drafts can be stored in different folders. Double-clicking on a folder shows the drafts in that folder. 
Working with folders and files works the same in all Windows applications.  
With File types, different types of stored drafts (files) can be selected.   

 WF1 and WF2: WinWeef files  

 WIF: files with which weaving programs can exchange designs.  
See Open WIF  

 All weaves: Both WinWeef and WIF files 
 

If the draft only contains an Analysis (see Analysis), the analysis window is immediately displayed. The file 
name is added at the top of the list of the four most recently opened files in the File menu. 

Save draft 
Saves all draft changes under the same name. If both the original version and the modified version (of the 
draft) need to be kept, select ‘Save as’. 
If the draft was not previously saved, the Save Draft window appears. See Save draft as… 
If a draft has been saved, the status bar of the WinWeef screen will remove the 'modified' message and if 
it was a new draft, the file name will now be listed in the title bar of the WinWeef window. 

Save draft as 
Open the screen 'Save draft’. Give the design a name and click Save.  
If by any chance a file name is chosen that already exists in the selected folder, WinWeef will warn and 
ask if this existing draft should be overwritten.  
 
When a design has been saved, the status bar of the WinWeef screen will remove the 'modified' message 
and if it was a new design, the file name will now be listed in the title bar of the WinWeef window. 
 

   TIP: working with folders  

Storing drafts that belong together in one folder, makes them easier to find.  
• Create new folder: Create a new folder in this folder  
• Parent folder: show the contents of the folder above  
• Click on a subfolder: show the contents of the subfolder  
 
First select the correct folder before saving 
 

. 

New folder 

 
Show parent  
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Open WIF 
A Weaving Information Format (WIF) is a file with a weaving design according to an American standard, 
which allows other weaving programs to exchange designs. Because this is not WinWeef' s own file 
format, information is lost in such a file format. Therefore, when rereading from a WIF file, some design 
features may return to a default value.  
 
With a WIF file, the threading is scrolled all the way to the right by default. (see menu Settings, 
Preferences, Threading, Threading from the right) and a palette is used: (many) permanent colors in the 
color palette.  
 
If a WIF file is read from another weaving program and that design contains white threads (the same as 
the background color which is white by default) then it is suggested to replace this color with a color 
selected in menu Settings, Preferences, More, 'Convert white in the WIF'. 
 
Further the menu option ‘Open WIF’ is identical to the menu choice ‘Open draft’.  

Save as WIF (Dobby 2.0) 
The same tips apply for 'Save as WIF' as for 'Save draft', but as described in 'Open WIF', information is 
lost when saving as a WIF file. It is strongly recommended to save a draft before or after saving it as a 
WIF, as a WinWeef file! If the draft is first saved as a WIF, then 'Save draft as' must be selected in order to 
be able to choose 'WinWeef Drafts'. The file name can of course be the same, because the extension for 
a WinWeef file is not WIF, but WF2. It can be useful to save a WIF file in a folder from which the other 
weaving program reads, because then only in one of the two weaving programs has to be browsed 
through the folders. 
For the Dobby 2.0: Settings – Draft – convert to Liftplan and save as WIF – file.  
 

Remove draft 
Opens the Remove Draft window. Select the draft and click Remove. Press Confirm.  
The draft is also removed from the list of four most recently opened files.  
Attention: the draft cannot be opened anymore!  
 
Drafts can also be removed in the 'Open Draft' and 'Save Draft' windows.  
Click on a file in these windows and choose 'Delete' from the right mouse menu. This way the file name is 
not removed from the list of the four most recently opened files. 
 
  TIP: Rename  

In the windows ‘Open draft 'and Save draft', the name of the draft can also be changed via the right 
mouse menu. 

 

Find draft 
Opens a window in which the names of the drafts plus detailed information are given.  
For each weave the: 'Title', 'Number of shafts', 'Number of treadles' are shown, and whether it concerns 
an analysis design.  
Because this takes a lot of extra time, a progress bar is shown at the top of the window during this 
process, indicating how far WinWeef is.  
If 'Find draft' is selected again, the previous view is displayed immediately.  
 
Options in this window  

 Open draft: select the draft and click OK  

 Remove draft: select the draft and click delete. The file name is removed from the list of the four 
most recently opened files in the File menu and the list in 'Search draft' is changed immediately 

 Sort: click on the column to be sorted  

 Cancel: close this window 
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Print 
Opens the Print window, which has three tabs.  

Margins in millimeters 

Set of the white spaces on top, bottom, left and right side.  
Set of the margin between the parts, this is the space between threading and tie-up, and tie-up and 
treadling. 

Text on print 
Enter a text for the print.  

 Font: set the font, size and style 

 Default: The default setting is selected. This is font 'MS Sans Serif', font style 'Normal', font size 8.  

 Delete: deletes the entered text.  
The text can only be printed if the option for one sheet of paper is selected.  

Print settings 

This tab consists of 4 parts.  
 

'Printing parts' determines what will be printed  

 Complete: with the right squares and the right colors.  
If threading and tie-up are not printed at all, more space is created for the printing of the 
drawdown, and possibly the treadling. Ditto for when tie-up and treadling will not be printed.  

 Grid only: only the empty grid is printed 

 Not: if both options are not chosen, this part will not be printed  

 Squares and/or numbers: this selection is only visible if drawdown and tie-up are not printed. 

 Print in black and white, this saves color toners  
If either only threading or only treadling is printed, it is assumed that this is for threading through the 
heddles or weaving itself. As much as possible will be printed on the paper.  
By choosing 'Squares' and / or 'Numbers' it is possible to see how it looks.  
With squares only: 

 
With ‘squares’ and ‘numbers’ 
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With numbers only: 

 
 
The drawdown will be printed as it was shown in the WinWeef window, with or without a grid and in the 
same distortion (see Settings, Preferences), only as a grid, or not at all. 
‘Size’ determines how big the print will be.  

 Square size in mm: Changing the square size changes the number of warp and weft threads to be 
printed.  

 Calculate max: calculates the maximum number of threads that can be printed for the selected 
square size. The settings in 'Print parts' are taken into account.  

 Warp and weft threads: the first and last thread to be printed.  

 Thread numbering: a different numbering method can be chosen than in the design screen. 
 

If, after calculating the maximum number of threads in 'Print parts', extra parts are clicked on, the number 
of threads in 'Size' is automatically adjusted.  
However, if parts are omitted, this does not happen. This way, white space can be created. This can of 
course also be done by printing fewer threads. 
 
‘Information’ determines which information is printed in addition to the design.  
The name of the weaver of the design or of the owner of WinWeef is always printed.  
Other information to be printed:  

 Title  

 Date  

 File name  

 Path, which also prints all folders and subfolders in which the draft is stored. This makes it easier 
to find the draft later on, but it looks less attractive.  

 Owner, this is mandatory if the draft was designed by another weaver. 

 Text on print, this text can be entered in the 'Text on print' tab  

 Page numbers, only possible with 'More pages'  

 Bars, only possible if this has been determined in the Analysis, Calculate bar menu. See Analysis 
Determine number of bars. 
 

‘Paper’ determines the number of pages and orientation of the print.  

 Multiple: If more warp and / or weft threads need to be printed than will fit on one page, then 
'Paper' can be set to 'More pages' The number of pages needed to achieve the desired number of 
threading and treadling threads is immediately displayed. 
 

NOTE Now 'Calculate max' will indicate that all warp and weft threads can be printed! This could cost 
hundreds of pages and therefore an adjustable maximum has been built in to limit this. See Settings, 
Preferences, More. If in such a case 'Print' is clicked, the set maximum will be reported and no print 
preview will be shown until the number of pages has been sufficiently reduced by specifying fewer 
threads and / or smaller squares.  
 

 Orientation: The design can be printed in portrait or landscape orientation. In the case of one 
sheet of paper, this also affects the maximum number of warp and weft threads to be printed. 

 
Buttons on this tab  
The 'Printer' button can be used to select a printer other than the preferred printer set in Windows. 
The print preview is built up with the 'Print' button. This building up, as well as changing the percentage, 
but also the printing itself, takes longer as more and smaller squares have to be printed. In case there will 
be too many squares, the print preview screen will remain empty! 
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Print preview  

 Percentages list: determines the size of the print preview on the screen. It gives a good view of a 
page. Zoom is possible.  

 Back returns to the 'Print draft’ window to, for example, set something else or to go back to the 
WinWeef window after printing.  

 Print this / all pages: indicates whether only this page should be printed. If there are many pages, 
it is useful to print one page first to make sure that all settings are correct. The print may appear 
slightly different on paper than on the print preview. 

 With the '<<' and '>>' button can be browsed through the pages. WinWeef starts with multiple 
pages in the top left corner, then continues to the page to the right of it until all warp threads and 
the tie-up are printed. Then the next row of pages, and so on. The page number, if any, is shown 
at the top right of each page. 

Drawdown to clipboard 
For the documentation of a design, it may be desirable for an image of the design to be available. With 
this menu choice, WinWeef creates an exact image consisting of threading, tie-up, treadling, drawdown 
(or analysis) and the rulers as they are in the WinWeef window at that same time. This image is copied to 
the Windows clipboard, so that within the word processor or the image program,  download the image with 
'Paste'. If the grey around the threading, tie-up, treadling and drawdown is not desirable, click on the color 
field to the left of it in Settings, Preferences, More, Color objects and, for example, select white.  
If the ruler must disappear, type 0 in Settings, Preferences, Thread numbering. 
To copy an image of threading, tie-up, treadling, drawdown (or analysis) separately to the clipboard, select 
'To clipboard' on the desired item with the right mouse menu. 

Most recently opened files 
In the File menu, the last opened or saved files are kept behind the numbers 1 to 4. By clicking on one of 
these choices, this design will be opened immediately. If something has been drafted that has not yet 
been saved, it will first ask if the changes should still be saved. If 'No' is selected, changes will be lost.  

Close 
Close WinWeef. If the last change has not yet been saved, the first question is whether the changes 
should still be saved. If 'No' is selected, changes will be lost. 
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Menu Edit 
This menu consists of 4 parts: 
 
Editing blocks  Editing complete segments Restore and miscellaneous 

 

 

 

 

 

Editing blocks is only possible in Block mode. Block mode can be selected in this Edit menu (2nd part of 
the menu), but it can also be done with [F2], the Edit icon on the toolbar or with the right mouse menu of 
threading, tie- up, treadling and analysis. See 'Block mode'  
The actions performed on a block can be undone by immediately choosing Recovery (see third part of this 
Edit menu). 

Copy (block mode) 
Select the block in block mode, and select Copy.  

 
The block is placed on a WinWeef clipboard and can be pasted elsewhere.  
WinWeef uses different clipboards for threading and treadling.  
The block is not saved when the draft is closed. It is also not possible in 
this way to copy blocks from treadling or threading to another draft. 
For copying to Word via the Windows clipboard, see ‘To clipboard’. 
 

Paste (block mode) 
With Paste, a block of the WinWeef clipboard is placed in the draft. Paste in block mode is only possible, 
when a block has been placed on the WinWeef clipboard with Copy or Cut. 

Insert a block 
Place the insertion point where the block is to be inserted. The insertion point is a green line between two 
threads. Select Paste.  
The block is now inserted in threading or treadling, the threads behind the insertion point will slide. 

Replace threads 
In block mode, select the threads to be replaced by the block and select Paste. The selected block is 
replaced by the block from the WinWeef clipboard.  
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In both cases, the pasted block is immediately selected as a block, so that other block actions (such as 
Mirror, Flip and Scroll) are immediately possible. 

Paste in tie-up mode 
In the Tie-up mode a rectangle of squares is copied. When Pasting, the same size of that rectangle must 
be specified in order to paste. If the size of the rectangle to be pasted is not correct, WinWeef will report 
this and indicate the width and height it should be. 

Paste in Analysis mode 
In Analysis mode WinWeef pastes the copied block without further conditions from the indicated top left 
point of the piece of analysis to be overwritten. 

Repeat paste (block mode) 
When making a draft, certain parts are repeated more often than just once. The number of times the same 
block must be pasted can be specified with 'Paste often'. 
 
Copy the block in block mode  
Place the insertion point where the block is to be inserted, or select threads to be replaced (see Paste). 
Select 'Repeat Paste.  
Enter the number of times to repeat the block. 
 

 

 
Select the block in the block mode. Select Edit 
- Copy 

 

 
Place in block mode the insertion point on the 
right place.  

 

 
Select Edit – Repeat Paste and have it paste 
twice. 

Insert (block mode) 
Insertion of empty threads in the threading or treadling.  
Place the insertion point where new threads are to be inserted. Select Insert and specify how many 
threads to insert. 
 
The threads to the right of the insertion point in the threading, or below the insertion point in the treadling, 
move. The newly inserted threads are empty and have the default color defined in Settings menu - 
Preferences - Default color. See Settings – Preferences. 

Cut (block mode) 
With Cut, threads are removed from a certain part and replaced elsewhere.  
In the threading, the threads slide to the right of the cut block to the left, in the treadling, the threads 
underneath slide to the top.  
The cut block is placed on one of the WinWeef clipboards and can be pasted elsewhere in treadling or 
threading. See Paste. 
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Remove (block mode) 
When removing a block, the threads of the threading to the right of this block, slide to the left, and in the 
treadling, the threads under the block slide up.  
The removed block is not placed on a WinWeef clipboard, and therefore cannot be placed in the draft with 
'Paste' or 'Repeat pasting’. 

Clear (block mode) 
Clear means that all squares in that block are emptied. In the threading and treadling, the color of the 
threads in the cleared block also becomes the same as the default color in the Settings, Preferences, 
Default Color menu. See Settings - Preferences.  
The difference with Delete and Cut is therefore that the space for the threads remains. 

Mirror (block mode) 
In Mirror, the threads on the left and right are swapped in the threading, in the treadling the threads on the 
top and bottom, in the tie-up and analysis the squares on the left and right. Mirroring again creates the 
initial situation. 

 

 
A selected block 

 

 
Mirrored 

Flip (block mode) 
In Flip, the shafts at the top and bottom are swapped, the treadles on the left and right in the treadling, in 
the tie-up and analysis the squares at the top and bottom. By flipping over again, the initial situation 
arises.  
 
Flip is like mirroring in a different direction. 
 
Selected block in 
the tie-up 

 
Flipped (over) 

  

Wrap (block mode) 
In Wrap, threads and squares are moved a specified number of positions. The squares that slide out of 
the screen will reappear on the other side: as if rotating an image on a cylinder. With 8 shafts, a maximum 
of 7 positions can be wrapped.  
 
Wrapping can go both ways. A positive value turns upwards in the threading, tie-up and analysis (that is in 
the direction towards the rear shafts in the threading) and in the treadling to the right. With a negative 
value it works the other way around.  
Indicate how many positions the threads have to wrap. 
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A selected block 
 

 

Wrapping two positions 
 

 

Horizontal Wrap (block mode) 
Horizontal Wrap is at right angle to Wrap.  
The squares that slide out of the view, will reappear on the other side: like a whirling image on a cylinder. 
With a block width of 20 threads, a maximum of 19 positions can be twisted.  
Turning can go both ways. With a positive value the twist will go to the left in the threading, tie-up and 
analysis and upwards in the treadling. With a negative value it will go the other way.  
Indicate how many positions the threads should slide.  

Rotate (block mode) 
Rotation is only possible with a block in the Tie-up and Analysis. Rotation is only possible without losing 
squares, if the block is square. If the block is not square, WinWeef determines from the top left corner of 
the block which side is the shortest. It will be rotated within the size of that square. Rotation is always one 
step to the left, which is counter clockwise.  
 
Example of a block of 5 high and 4 wide in the tie-up, WinWeef determines the rotation in the square with 
a size of 4 by 4 squares. 
 

    

Stretch (block mode) 
In Stretch, each thread in the block is duplicated a number of times next to itself. The threads to the right 
of the block in the threading, slide. For example, stretching is done in preparation for a technique like 
'Summer and Winter' or Networking.  
Specify how often to duplicate each thread.  
Stretching can also go the other way: shrinking. This is accomplished by entering a negative number. At 
the value -4, the first thread of a group of 4 threads is always saved and the rest removed.  
 
Example of a block in the tie-up in which the value 2 is specified in Stretch. 
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Selective stretch (block mode) 
In Selective stretch of a block, only the threads are duplicated by specified shafts or treadles a specified 
number of times. The threads to the right of the block in the threading slide, the threads under the block in 
the treadling slide.  
 
WinWeef asks for the following information:  

 Number of times each thread has to be duplicated.  

 For a block in the threading 'Threads on which shaft(s) / series?'  

 For a block in the treadling 'Threads on which treadle(s) / series?'  
A series can consist of single numbers, separated by commas, or a number up to and including another 
number, connected by a dash. 
 
Example of a block in the threading in which ‘Selective stretching' specifies the value 2 and that for the 
series of shafts '8,1-3' (so shafts 8, 1, 2 and 3, where shaft 8 is the rear shaft): 
 

  

Invert (block mode) 
With Invert all filled squares are emptied and all empty squares are filled.  
This action is  

 useful in the tie-up and analysis,  

 not possible in threading, because an end can only go through one shaft.  

 in the treadling only possible if multiple treadles per pick are checked (see Settings menu, Draft, 
Treadling). 

 
Example of a tie-up in which two blocks are inverted 

    

Complete threading to treadling 
The most left thread of the threading will be copied to the treadling from the top thread down. The number 
of treadles will be the same as the number of shafts.  
In the treadling, the weft threads retain the color they had originally in the treadling, but if more than one 
color was applied in the threading, ‘Copy colors from threading?’ will be asked.  
If this is confirmed, the color of the thread from the threading will also be included in the treadling. This will 
create areas in the design with the same warp and weft color. To see structure in the areas, select to 
show it as 3D (three dimensions). See Settings > Preferences > Draw 3D. 

Threading to treadling mirrored 
Because it can be desirable to weave the last thread of the draft first, the threading can be mirrored to the 
treadling, so the rightmost thread of the threading will be at the top of the treadling. 
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Threading of block to treadling 
It is possible to copy part of the threading to the treadling.  

 Make a block of the section of the threading to be copied to the treadling. 
Select Edit > Copy.  

 Place the insertion point in the treadling where the threading is to be copied.  
 Select Edit > Threading of Block to treadling.  

The number of treadles is not adjusted. If there are more shafts than treadles, the front shafts are not 
copied. The question is always asked 'Copy colors from threading?' (see 'Threading to treadling’) 

Treadling block to threading 
It is possible to copy part of the treadling to the threading.  

 Make a block of the part of the treadling to be copied to the threading. 
   Select Edit - Copy.  

 Place the insertion point in the threading where the treadling is to be copied.  
   Select Edit – Treadling block to threading.  

The number of shafts is not adjusted. If there are more treadles than shafts, the right treadles are not 
copied. The question is always asked 'Copy colors from treadling?' 

Turn draft 
With Turn draft, the threading and treadling are switched. It is asked whether the tie-up should be 
inverted.  
Threading and treadling are interchanged, including the number of threads, number of shafts and number 
of treadles. With Liftplan or Multiple treadles per pick (see menu Settings, Draft, Treadling), a threading is 
created with ends through multiple shafts! 

Block mode 
Block Mode switches between the two possible modes of WinWeef: Drawing or Block mode. In Block 
mode, only blocks can be selected and actions can be taken on or with them.  
Since there will be continuous switching between Draw and Block mode, this can be indicated in many 
ways: Via the Edit menu, but also with [F2], by clicking on the block mode icon (which remains pressed as 
long as WinWeef is in block mode), by right-clicking in threading, treadling, tie up or analysis and then 
choosing Block mode or Drawing mode (always the first choice in a right mouse menu). 
 
Draw mode Block mode Block mode cursor 

   

Select block 

In WinWeef a block can be selected in a number of ways:  

 Drag with the Block cursor  

 Click on the first thread and [Shift click] on the last thread  

 Right mouse click  

 Edit - Indicate block… 
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Right mouse click with blocks 

Some options for working with Blocks are only available via the right mouse click. The first two parts of 
this menu offer the same functionality as Edit and Color. These are therefore not discussed in this 
chapter. The last 5 options work slightly different from the other menus or are only available in this menu.  

 Block from this point. The line or point at which the block cursor is positioned is marked as the 
starting point of the block.  

 Block to this point. The line or point at which the block cursor is located is indicated as the final 
end of the block.  

 Block over all. The entire part containing the block cursor is selected as a block. The complete 
threading, treadling, tie-up or analysis is therefore selected as a block. 

 Do not show block makes that the selection, the green grid, disappears.  

 To clipboard. The block is copied to the Windows clipboard and can be pasted into a Word 
document. 

Indicate Block 

 

Block selection is possible for both 
Threading and Treadling. 

Options in this window  

 Block selection in combination with Select Block. Specify of which threads the block consists. The 
first to the last thread that are currently visible on the WinWeef window are entered by default. 
These values can be changed and if the thread number is too high, the window will be displayed 
again after clicking OK.  

 Block right across. The first to the last possible thread are entered, this choice cannot be 
changed.  

 Block starting here. Determines the position of the insertion point. No value can be entered at 'up 
to and including thread’. This can, for example, indicate the thread number on which a block must 
be pasted.  

 Hide block. Makes that the selection, being the green grid, disappears. 

Go to 
With large drafts and/or when following an instruction, it can be useful to quickly browse to a specific 
thread. This can be done with the choice 'Go to', after which Threading or Treadling must be chosen.  
As default for the field 'Go to thread' the middle thread that is exposed in the WinWeef window, or else the 
last thread will be proposed.  
Enter the desired thread number here.  
After clicking OK the browser will scroll to the indicated thread, which will then appear as the middle 
thread in the WinWeef window. 
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Restore threading, tie-up and treadling 
After a number of actions, the threading and/or treadling and/or tie-up may not look as desired. If the draft 
has been saved in advance (interim storage is highly recommended), the draft can be scanned again.  
 
With the menu Edit - Restore… the desired item can be restored. This can also be done with the shortcut 
keys [F6], [F7] and [F8]. There are some limitations to the restoration.  

1. After restoration it is possible that the number of shafts in threading and tie-up is not the same. 
Ditto for the number of treadles in treadling and tie-up.  

2. WinWeef created a restore point only for the following actions  
a. drawing a line, 
b. shifting a shaft or treadle,  
c. perform an action with a block  
d. performing a Technique.  

Drawing one or more squares or drawing a diagonal does not create a restore point! 

Copy from 
If a new design is partly based on a previous draft, it is not necessary to start from scratch. There are two 
possibilities to use the first design.  

 Open this draft with File – Open draft, Save it directly under another name with File - Save as.  
A copy of the old draft has now been made. This copy can be changed as wished.  

 Start a new design with File – New draft. Copy the desired parts of the old draft via Edit - Copy 
from other drafts.  

 Merge two drafts: one draft must already be saved in this case, the other draft is on the screen. 
Select Edit - Copy From. 

 
Parts of this window  

 File. Indicate the draft from which to copy. The Browse button opens the Open draft window. See 
Open draft.  

 Which parts. Indicate which parts must be copied from this draft.  

 Ends and/or colors. If 'Ends and colors’, or 'Ends only' are copied, the number of shafts increases 
in the threading if a larger number of shafts is used in the specific file.  

 Which sequence. If more than one part has been selected under Which parts, only Copy all can 
be selected. The other options are also available for one part. 
o Copy all: the number of shafts from the indicated file will be adopted. If that file has more warp 

threads, that number is used.  
o From End: the copied part is inserted after this end. 
o Interleave: the copied part is interleaved with the draft already on the screen. 2 every 3 means 

that 2 ends from the indicated file are always placed, then 3 ends of the design appear on the 
screen, then 2 ends from the file, etc.  
In the case of  interleaving, it is then necessary to indicate how to do so.  
Interleave after means that the first end remains the first end of the draft shown on the screen.  

Separate shafts means that the shafts of the other draft are added to this design. The 
number of shafts thus becomes the sum of the number of shafts of both drafts. 

Transparent Copy 

A liftplan can be transparently copied over an existing liftplan; treadles are added, without the need to 
insert weft rows. An example is a lampas with 3 tie shafts, both weaving twills. First, create a design for 
the pattern, see figure 1, the red squares. With turn draft, the blue tie rows are inserted. With transparent 
copying, the tie shafts of the pattern wefts are added, without the existing wefts having to move on. 

 
The figures: 
Extra treadles can be added to a liftplan, figure drawing 1.  
The extra treadles are saved in a separate file, fig. 2, with as many rows as the final design, exactly where 
they need to be placed and in the right color.  
Figure 3: Figure 2 is copied transparently over figure 1.  
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1           2    3 
Copying figure drawing 2 transparently on figure drawing 1. Figure Drawing 3 is the result. 
 
Open figure 1. Go to Menu Edit> Copy from > Browse file, select figure 2> check treadling and 
Transparent and OK. 
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Remove from 
A draft with tie-shafts or with a plain weave treadling or a draft with an echo- threading, has regularly 
spaced shafts or treadles that can be removed with 'Remove From'. 

 

 
A threading with tie-shafts 

 

 
The settings to remove tie-shafts.  
 
 

 

The threading after the ‘Remove from’ action 

With ‘Remove from’ also a regular color repetition can be removed.  
 

 

 
 
 
A threading with repeating quadruples of 
equal colors 



WinWeef 10.3 Manual 

 22 

 

 
The settings to constantly remove 4 colors 
and replace them by a default color. 

 

 

The threading after the ‘Remove from’ action 

Numerical input 
In some weaving magazines, the threading and treadling of a draft are written as series of digits (see also 
menu File - Print draft - Print preferences - Digits). With 'numerical input' such a series can be entered 
quickly.  
 
The input starts with thread 1.  

 Type the number of the shaft  

 Press [Enter], the next thread number is displayed  

 Type the number of this shaft  

 Press [Enter], etc. 
 
'Browse' through the threads can be done with the Back and Forward arrows. The number of the thread to 
be viewed can also be entered directly. Afterwards corrections are possible. 
 
There is no control on shaft or treadle number, so values that are too high do not lead to drawing a shaft 
or treadle.  
 
For treadles, multiple treadles can be entered as a sequence, for example, 1,6-8 to indicate treadles 1, 6, 
7, and 8. There is no control on one or more treadles per pick (see menu Settings, Draft, Treadling).  
 
If OK is clicked, the entered threading or treadling is displayed.  
 
Note that it is not possible to enter the threading and treadling at the same time. At first one series has to 
be entered, then click OK. Then select Edit - Numeric input and enter the other series. 
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Working with colors 
This chapter describes how to work with colors when designing.  

Edit color window 

 
 
The color can be indicated in this window.  
A color is chosen by clicking on the 48 basic colors, or by clicking in the rainbow colors section. By 
dragging the slider on the right, the brightness can be changed. Each color is determined by a value from 
0 to 255 for the Red, Green and Blue components. The value 255,255,255 is the brightest white, the value 
0.0.0 the darkest black. So there are 2563 = 16,777,216 colors possible. 

Color in Block Mode 
If in block mode Color - Change Color is selected, the Change Color window appears. In the window, the 
color of the first thread from the block is selected. Clicking on OK immediately gives all threads in the 
block the same color as the first thread.  
Choose a different color and then OK gives all threads that new color. 

Color in Draw mode 
Creating a block and then changing color to color one thread is laborious. With [Alt click] the color of one 
thread (or color one square the analysis) is possible. The Windows color palette appears and a thread in 
that color is immediately drawn in the indicated square. If a thread was already drawn in that square, it will 
change color. 
 
With [Shift] click a regular line is drawn between two points, with [Shift] [Alt] click the Windows color 
palette is shown and a line is drawn in the indicated color. 

Right mouse menu and color 
The right mouse menu gives a number of options for working with color.  

 Colored thread. In the Change color window, the color of this thread can be selected. Either a new 
thread is drawn in this color, or the thread color is changed into this color.  

 Draw Line in Color. The Change Color window appears. A line is drawn between the last point 
and the indicated point in the selected color.  
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 Brush Color Thread. Places a thread in the brush color or changes the color of this thread to the 
brush color. See Using Color Palette. 

 Brush Color Line. A line is drawn between the last point and the indicated point in the brush color. 
See Using color palette. 

 Color all threads on shaft / treadle. The Change Color window appears. All threads on the 
indicated shaft or treadle will get this color. 

Color palette 
At the far right of the WinWeef window is the color palette.  
The color palette shows all the colors that are already or will be used in the design. A color does not 
(yet) have to be used for a thread.  
 
When the mouse cursor is moved over threads in the threading or treadling, the color palette indicates 
the color under the mouse cursor with a cross.  
 
When colors are added, they are added at the back of the color palette. When the row is full, the color 
patches are reduced so much that more columns with color squares fit. This continues until a color area 
is only 3 by 3 pixels in size.  
 
To prevent colors that no longer or not yet appear in the design, disappear from the color palette, a 
color can be made permanent. A permanent color has a dotted outline. 

Using color palette 

The color palette can be used in two ways to color threads.  

 Block mode - Make a block in threading or treadling and click on the desired color in the Color 
palette. WinWeef will ask ‘Color block?'.  

 Draw mode - Include a color from the color palette in the brush as Brush color.  
[Ctrl Click] on a color: the color palette turns this color into the brush color.  
Then [Ctrl Click] on a shaft, treadle or analysis square gives one thread in the brush color. Or 
select 'Thread in brush color' in the right mouse menu. If there was already a thread, it will now 
get the brush color.  
Click gives the 'normal' font color, [Ctrl Click] the brush color. 

Right mouse menu on color palette 
The color palette has its own right mouse menu.  

 Add color. A color can be added to the Color palette via the Color window. This is always a 
permanent color. A color added in this way is not yet used in the design and would be removed 
immediately if it was not a permanent color. A new color is always added at the bottom of the 
palette.  

 Change color. One of the colors in the color palette can be changed via the Change color window. 
All threads with that color then get the new color.  

 Remove color. Only permanent colors that are not yet used in the design can be removed.  

 Permanent color. By clicking this option, this color becomes a permanent color. 

 Sort by position of color. The colors can be sorted with the right mouse menu in order of 
occurrence within threading or on the internal value of a color.  

 To clipboard. If, for example in a weaving project, the exact color of a thread has to be shown, the 
right mouse menu can be used to copy the indicated color to the clipboard.  
In the Word processor download that colored square via Edit > Paste. 
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Color menu 
This chapter discusses the Color menu. 

Change color 
Shows the Edit color window. See Working with colors 

Copy (block mode) 
Copy the selected block. This is the same function as Edit – Copy. See Edit-Copy 

Paste (block mode) 
The order of colors of the block on the WinWeef clipboard is pasted from the insertion point. The position 
of the shafts and treadles is therefore not changed.  
The block can be placed on the WinWeef clipboard with Edit - Copy, Edit - Cut or Color - Copy 

Repeat paste (block mode) 
The order of colors of the block on the WinWeef clipboard can be pasted a number of times from the 
insertion point. The positions of shafts or treadles are not changed, only the color series saved after Copy 
is used a specified number of times.  
The block can be placed on the WinWeef clipboard with Edit - Copy, Edit - Cut or Color – Copy. 

Insert (block mode) 
The colors move a number of positions over from the insertion point, threads are colored in the default 
color in the vacated places. The positions of the shafts or treadles are not changed. 

Cut (block mode) 
The colors of the threads in the block are removed, the color order of the threads after the cut shift 
forward. The positions of shafts or treadles will not be changed.  
 

   
 Threads 5 and 6 are selected After Color - Cut 

The colors from thread 7 onwards are 
shifted 2 positions backwards 

Clear (block mode) 
When clearing the threading and treadling, the color of the threads in the emptied block will be the same 
as the color that is set as default. See Settings – Preferences - Default color. 

Mirror (block mode) 
With Mirroring, the colors of the threads on the left and right are swapped in the threading, in the treadling 
the colors of the threads above and below are swapped. By mirroring again, the initial situation is 
returned. 

Stretch (block mode) 
When stretching a color, each color is duplicated next to itself a specified number of times. The colors to 
the right of the block in the row will be moved up. WinWeef asks 'How many times?' when stretching. By 
default it is 4.  
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Stretching a color can also go the other way: shrinking. This is achieved by specifying a negative number. 
With a value of -4, the first color of a group of 4 colors is saved and the rest is deleted. 

Invert (block mode) 
The colors within a block are replaced by the color that has the inverted value in terms of the Red, Green 
and Blue value. The color 255,100,0 will then be 0,155, 255  
Two colors are inverted when the sum of their Red, Green, and Blue values each is 255.  

Gradient (block mode) 
In a color series, the colors gradually change from one color to another. Such a color series can be made 
with this option.  
• Select the threads to be colored according to the color sequence.  
• Select Color - Range.  
 
In the Color Sequence window, the number of threads in the selected block is displayed. The number of 
shafts and treadles is also displayed.  
The first and last threads in the window are the same color as the first and last threads in the block. These 
colors are shown in the From and To areas. The threads in between gradually change from one color to 
another. 
 
The color of the From and To areas can be filled with the Change color window or with one of the colors 
from the color palette. The color palette is displayed at the bottom of the window.  

 Change color  
o Click the square.  
o The square is selected and the Change color window appears, a different color can now 

be selected.  
o Click OK and the square gets the selected color.  
o The square remains selected.  

 Color palette  
o Click the square.  
o The square is selected and the Change color window appears. Click OK.  
o Click on the wished color from the color palette.  
o Confirm. 

 
If the color is changed at 'From' or at 'To', the color range will be adjusted. 
 
Example color series: 

 
 

Selected Block. 
First thread is green, last thread is yellow  
 

 
 

 
Color range window for this block.  
The 'From' color is the green from the 
threading, 'To' color is the yellow from the 
threading.  
 
At the bottom is the color palette of this 
design. 
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In this case, the From and To color has not  
changed. WinWeef now graduates the colors 
from green to yellow. 

Replace 
If for some reason a color is not satisfactory, for example because no material is available in that color, 
one color in the design can be replaced by another. This can be done both for the threading or the 
treadling, but also for the entire design in one go.  

 Click on the color field 'Color to replace' to select it.  

 Now click on the color to be replaced in the color palette.  

 Click on the color field 'New color' and click on the new color in the color palette or click on 
Choose color and select the correct color in the window.  

 Indicate in which parts the color must be replaced: threading, treadling or entire design. 
After clicking OK, the number of threads that have been given the new colors will be reported when the 
color is found, for example '36 threads replaced in treadling '. 

Color symbols 
For use of a WinWeef design in an environment where colors may appear unclear, to save color ink, or for 
a (teaching) course, colors can also be displayed as symbols.  
WinWeef shows the colors as symbols, if this is selected in menu Settings - Preferences - Color display 
for 'Colors as symbols'. See Settings - preferences.  
 
In the Color symbols window, the colors from the color palette are shown with symbols next to it. WinWeef 
has 12 different symbols.  
The combination color - symbol can be changed by choosing the letter of a symbol next to the color. 
 
In a design with many colors, the window can be too narrow to show all the colors. It will be displayed at 
the bottom of the window. For example, it says '3 colors out of sight!' Making the window wider will allow 
more colors to fit in. 
  
With Initiate all cells are cleared and all colors must be manually linked to a symbol.  
 
Examples of color grids: 

 

Colored threading 

 

Choice of symbols 
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Effect in threading  

Only used colors in color palette 

When reading a design from a .wif file from another weaving program, the color palette can contain 
dozens of colors that are not used in the design. This menu option can be used to remove all unused 
colors from the palette. 
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Menu Show 
This chapter discusses the menu Show. 

Zoom 
Turning Zoom on or off switches between the two square sizes that are set. See menu Settings – 
Preferences- General. Switching between these two settings is faster by clicking on the icon for Zoom in 
the toolbar or by [Ctrl Z] (or selected differently: [F10]).  
This makes it possible to quickly switch between very small and very large squares.  

  
The square size of the display is easy to adjust by decreasing or increasing. 
 

Decrease    Increase 

  
[-] [+] 

[F3] [F4} 

Back view  
This selection shows the back of the drawdown, i. e., warp turns into weft, and vice versa.  

Turn weaving 
This selection not only shows the reverse of the drawdown, but the entire threading is mirrored.  

Hide toolbar 
To get a little more space in the WinWeef window, the toolbar can be temporarily hidden. If the toolbar is 
hidden, it can be shown again by ticking the option under 'Hide toolbar'. When WinWeef is restarted, the 
toolbar is always present at the top of the window. 
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Menu Settings 
This chapter discusses the menu Settings 

Draft 
This screen defines the settings for this design. These settings may differ per draft. Settings related to the 
loom or the weavers preference, are defined in Settings - Preferences.  
 

 Name. The name is above the screen and printout of the draft.  
In the File - Find draft menu, the name can be used to retrieve a draft.  

 Number of shafts/ treadles. Number of shafts and treadles used for this draft.  

 Max. length of threading/ treadling. Indicates how many threading and weft threads will be used.  

 Tie-up and treadles. 
o Tie-up. Indicates which treadles are connected to which shafts. There is only one treadle 

per pick. Check More treadles per pick for skeleton tie-up. 
o Lift-plan: indicates which shafts will lift up with a pick.  

 Krokbragd is a special way of drawing. This is the only case in which each square of the treadling 
can have a different color.  
 
Attention: The tie-up of the weaving is the invert of the drawing in WinWeef. 

 

 
 

 Threading. The option for ends through multiple shafts is extremely uncommon, but with a 
damask design for drawloom it might be useful. 
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Changing number of shafts or number of treadles afterwards  

If the number of shafts is decreased, shafts will have to be removed. Indicate which ones need to be 
removed, so that in a draft in which a threading has already been entered, not the wrong shafts disappear.  
 
If the number of shafts or treadles is decreased from 8 to 6, WinWeef reports that 2 shafts are removed 
and suggests doing so from shaft / treadle 1, so to remove shafts 1 and 2. 
 

 
 
If the number of shafts or treadles is increased, WinWeef suggests adding them before shaft/treadle 1. 
Choosing for another location and / or adding the shafts after a certain location is possible. 
 

 
 
If on a later moment the wish occurs, that the new shafts or treadles should have been placed differently, 
they can be moved with Wrap or via the right mouse menu, 'Shaft/ treadle forwards' or 'Shaft/ treadle 
backwards', or with ‘Move shaft to position…’.  
 
If there is liftplan, but the number of shafts is not equal to the number of treadles, then treadles or shafts 
are automatically added to enable liftplan again. 

Converting the type of tie-up 
Converting of a tie-up to a liftplan: 
 
Tie-up Converted to Liftplan 
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Converting from liftplan to a tie-up can yield much less, but also many more treadles.  
WinWeef has no preference for a 'nice' tie-up, so the tie-up can look very unusual. Via the right mouse 
menu in the tie-up, make changes in the tie-up with treadle to the right/ left, without changing the 
drawdown, because the treadling changes also. 
 
When converting from liftplan to tie-up, the 'More' button offers four options.  

 Efficient convert to tie-up. A separate treadle is used for each type of weft. Starting with the very 
first pick for the left-most treadle. 

 Each weft has its own treadle. This can be helpful with a mechanical dobby loom. 

 Do not convert does not lead to a different tie-up or treadling, but it is possible to change in the tie-
up. After all, a tie-up can be changed… 

 Block in treadling becomes tie-up. In order to obtain a desired tie-up immediately when converting 
to a tie-up, a block can be selected in the treadling in which the desired tie-up occurs. With 'Block 
in treadling becomes tie-up’, this block becomes the tie-up. If not all the required combinations are 
present in the indicated block, the conversion will not succeed! 
 

 
Indicated block in the treadling with a liftplan. 

Converting to a tie-up with the option ‘Block in 
treadling becomes tie-up’. 
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Preferences 
In this window the preferred settings for the display of the drafts and some fixed data of the loom are 
indicated. 

 
  

General 

This indicates the default colors and how the draft should be shown on the screen.  
 Square size in mm determines the normal size of the squares.  

 Zoom size in mm determines the size when zooming. See View – Zoom.  
It is useful to take large for one, for example 12, and small for the other, for example 2. In this way, 
quickly switch between a drawing view and a view in which a very large part of the design is visible.  
 
With a square size of 1 or 2, WinWeef does not draw a grid in the threading, tie-up and treadling, 
drawdown and analysis, otherwise the grid will become too predominant. 
With a square size up to 4, WinWeef does not draw a 3D structure, otherwise the 3D lines will become 
too predominant.  
 
Enlarging and Reducing is possible during designing. See View > Zoom. 
 

 Ratio. Determines the ratio between the height and width of the squares if they are not square due 
to a firm beat, use of specific material or a special technique. If the design is used for a crochet 
pattern, for example, the squares are one and a half times the width. At 'Ratio%' 150 is then 
entered. A maximum distortion of five times is allowed, so a minimum of 20% and a maximum of 
500%. 
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 Default colors. The different default colors can be changed by clicking on the desired color field. A 
different color can then be selected in the Windows color palette. The four colors must be 
different. For example, if the same default color is chosen for threading and treadling, WinWeef 
will say 'Color of threading and treadling are the same' and the OK button will be disabled.  

 Default color threading/ treadling. All threads where no squares have been filled in yet will be 
given this new color.  

 Default background color is used for the unfilled squares in threading, tie-up and treadling. For 
example, if white threads are used in the draft, it is possible to set this color to light grey. 

 Default color lines are used for all grids. 

  

 

In this example, the following default colors 
have been changed 
Background:       Light blue 
Lines:                  Dark blue 
Objects:              White (see More) 

General Thread numbering 

The thread numbering in threading and treadling.  

 Threads between determines how many threads there are between two numbers to be reported. 
So with a value of 10, tens are indicated in the threads. When using square size 1  when zooming 
in, there will be so many tens that these numbers will be superimposed. 

 Number of digits divides the numbering between the threading and treadling. With the value 3, a 
value on the far left, on the far right and in the middle will be shown. Thus, when the main screen 
is enlarged, the spacing between the numbers shown is also increased. 

 If the value 0 is selected, no rulers are displayed at all 

View 

Usually 'Color view' will be used. To view the structure of the weaving, select 'Structure View’ or ‘Color 
Symbols’. For special applications Black / white (via Structure View) or 'Color symbols' can be useful. See 
also menu Color - Color symbols. 

Threading and treadling 

 Shaft nos decreasing: front shaft becomes 1, the value rises backwards. In the tie-up the 
numbering in this order is vertical.  

 Threading nos decreasing: the further most right thread in the threading becomes 1, numbering 
goes to the left.  
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An example with ‘Shaft nos decreasing ’and ‘Threading nos decreasing’ 

 

 Threading from the right is automatically applied when a WIF- draft is read. With WIF it is common 
that the draft is made from the right -most thread and in such cases it is useful that when opening 
a draft WinWeef already browses directly to the far right. 

 Threading in black and white can be used, for example, if very light colors are used in the 
threading and especially in combination with small squares, the drawdown is difficult to see. By 
showing the threading in black and white (the drawdown itself remains in color), it becomes 
clearer.  

 Omit threading eliminates threading and tie-up from the main screen, leaving more space for the 
drawdown and the treadling. 

 
The options under 'Treadling' are analogous to those for 'Threading'. 

Draft 

 Leave drawdown empty: the drawdown is not drawn. With very small squares, a big screen and a 
very slow computer, browsing through the drawdown is very fast if the drawdown is not drawn.  

 Drawdown grid: the same grid is shown in the drawdown as in the threading, tie-up and treadling. 

 Sinking shed: an empty drawdown has the color of the warp threads. At the positions where a weft 
thread is inserted, the color of the weft thread appears. 
 
Do not check Sinking sheds 

 

 
Sinking sheds 

 
 

 

 Draw in 3D (three dimensions) does not only look vivid, it is also the only way to see how the 
drawdown is built up with the same colors in threading and treadling.  
The selection list determines which form of 3D drawing is used:  

o Normal leaves space between the threads and places a black line to the right and below 
each thread.  

o Thick draws a double black line on the right and below and a single black line on the left 
and above.  

o Simple leaves no space between the threads and puts a black line on either side of each 
thread.  

o Shadow distinguishes dark warp colors. It draws a dark grey line in the warp threads on 
the left and a black line in the weft threads at the bottom. 
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3D Normal 3D Thick 3D Simple 

   
 
3D Shadow 
 
 

  

  

 

Tie-up 

It depends on the 'school' where the tie-up should be in a draft. If the tie-up is moved by choosing 'Tie-up 
shown on left' and / or 'Tie-up shown beneath', then the treadling and / or threading are also moved. The 
ruler with the thread numbering and the sliders are also placed in the logical places. 
 
Tie-up left  Tie-up left and below  

  

Analysis 

Just like in the drawdown screen, drawing a grid in the analysis screen can be selected. 

More 
With the button More, extra setting options appear. 

 Language selection and Help text selection. WinWeef comes with a Dutch, German and English 
list. As soon as a language is chosen, all menus, messages, labels, hints and errors are taken 
from the selected file. All texts in WinWeef can be changed. See Appendix WinWeef and 
languages. 
WinWeef comes with a Dutch and English help text.  
 

 Make backup files. Like many other computer programs, WinWeef can ensure that when saving to 
a file, the previous contents of that file are not lost by securing the existing file under a different 
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name. The extension of that existing file was .wf2 or .wf1 or .wif (see Save draft) and is changed 
to .bak. The .bak extension is almost always the default backup extension in Windows.  
When saving the draft again, the existing WinWeef file is first written over that existing backup. So 
there is no more than one backup per WinWeef file. 
If it turns out that the saved draft was actually not good, but the previous saved file was alright, 
rename the backup file in Windows Explorer and give it the extension of the less good file. 
Suppose file MyDraft.wf2 is not sufficient, then look in the same folder MyDraft.bak and rename it 
for example MyGoodDraft.wf2. Now that backup file can be opened by WinWeef. 
 

 Max shafts, Max. treadles. These self-selected maximums apply when setting a draft in menu 
Settings, Draft.  
When generating a network threading or with block substitution, more shafts or treadles can be 
created than is set here.  
 

 Width analysis, Height analysis. The displayed drawdown is calculated and therefore does not 
cost any memory in the computer, but every square of the analysis is saved. In general, an 
analysis will not have to have the dimensions of threading times treadling. The maximum size is 
defined here. 
  

 Number of pages. In the File > Print menu choosing to print over multiple pages and with a large 
draft and / or large squares, could lead to an alarming and nonsensical number of sheets of paper. 
Defining what is an acceptable number of pages that may be printed in such a case, can be done 
here.  
 

 Spacing. For a clear space between threading, tie-up, treadling and the draft, the spacing 
between these parts can be increased. 
 

 Zoom. Since the Ctrl-Z key combination is reserved for undo in most Windows programs, one can 
choose to connect zoom in and out with the shortcut F10. 
 

 Color Objects. Determines the color of the window directly around threading, tie-up,  treadling and 
drawdown. The effect is similar to that of Default colors.  
Clicking on the color rectangular and setting this color to white, produces a nice result if the draft 
is copied to the clipboard. By clicking on the 'Color Objects' button, the usual color of the panels in 
the main window is restored.  
 

 Color Analysis.To make a clear difference between the normal draft window and the analysis 
window of WinWeef, the analysis window has a different color for threading, tie-up, treadling, draft 
and scroll bars. Clicking on the color button and setting this color to white, produces a good result 
if the analysis is copied to the clipboard. By clicking on the button 'Color Analysis', the usual 
yellow color of the panels in the analysis window is restored. 

 

 Convert white to WIF. If a drawdown is read from a WIF file of another weaving program and that 
drawdown contains white threads (threads with a color equal to Default color background) it is 
suggested to replace these white threads with this color. Clicking the button sets that color to light 
grey. 
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Analysis 
In this chapter, the analysis options of WinWeef are discussed. 

Analysis screen 
The great strength of the analysis screen is the conversion of a draft into a weaving design. For example, 
a structure can be copied in the analysis screen. WinWeef analyses the draft and calculates a threading, 
tie-up or liftplan, and treadling with which the drawing can be made. It will often be disappointing how 
many shafts and treadles a self-made draft will take. By simplifying and analyzing it again and again, a 
workable draft can be obtained.  
By modifying a draft copied from the draft screen a bit, the number of shafts and treadles can be reduced. 
 
Not only drawdowns can be copied in the analysis screen, any drawing can be made in it and converted 
into a threading, tie-up and treadling. The chance that a large number of shafts and treadles is calculated 
in drafts, is of course very big. 
 
Drawing in the analysis screen is the same as drawing in threading and treadling in the WinWeef screen. 
However, in contrast to the normal WinWeef screen, the drawdown itself is drawn here.  
In the analysis screen, working in block mode and with color is possible. This is done in the same way as 
in the WinWeef screen.  
In the analysis screen can be drawn in the threading, tie-up and treadling, but this does not effect the 
drawdown. 
 
The colors of the analysis screen are different from the normal WinWeef screen. The most prominent is 
the yellow frame of the screen. This prevents accidental work in the analysis screen. These colors can be 
adjusted, see Settings - Preference – Analysis. 

Switch between draft and analysis screen 
Switching between the analysis screen and the regular WinWeef screen is necessary to  

 Process a draft from the analysis screen into the regular WinWeef screen. When WinWeef has 
analysed the drawdown, and threading, tie-up and treadling have been calculated, the draft is 
transferred to the WinWeef screen when switching. There, the design can be refined to create a 
draft that can be woven.  

 A draft from the WinWeef screen can be transferred to the analysis screen. The drawdown itself 
can be changed there. After that WinWeef can analyse the changed drawdown and recalculate 
the threading, tie-up and treadling. 
When transferring a draft from the WinWeef screen to the analysis screen, WinWeef asks whether 
the draft should be copied to the analysis screen. 

Analyse 

This option analyses the drawing. Analyzing can be done with a Liftplan or a tie-up.  
In Settings – Draft it is indicated which tie-up is used. See Settings – Draft. 
 

Drawing of a fish in the Analysis 
screen 

Analysis with liftplan Analysis with tie-up 
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Calculate draft 
In a draft calculation, among other things, is mentioned which materials are used and how much of each 
material. WinWeef can perform these calculations, taking into account:  

 Warp take-up: weaving allows a thread to pass over and under other threads, making it shorter.  

 Loom waste: The length of thread that is lost when lashing on the warp and what stays behind on 
the beam, when finished weaving. 

 Washing shrink(age): The shrinkage of the material when it is washed.  

 Weft take up: A weft thread is slightly loose woven. 
 
If it is known how many meters of thread there are on a cone and how much the cone costs, then the 
complete order of the materials and the costs thereof can be calculated.  
 
If the same material is used more often, it is useful to keep the number of meters of thread per cone, the 
price, the usual number of threads per cm on the loom, together with the material, and – if there are- 
comments. All these aspects are used to the Calculate draft window. 
 
The Calculate draft window consists of two tabs: Draft and Material.  

 Draft: On this tab the calculations are made and the material for Warp and Weft can be selected. 
The materials can be selected from a list.  

 Material: This tab contains space to record all materials: Adding, removing or changing 
materials.The changes will be visible on the Draft tab when choosing warp and weft material.  

On the tab Draft, the numbers shown in black can be changed. The grey numbers are the result of the 
calculations by WinWeef. With ‘warp take-up’ and ‘washing shrinkage’ can be indicated whether the 
calculation should be performed with a % or with a number of centimeters. 
 

 
 
If, under ‘Warp’ ‘Threads per cm' and 'Number of warp ends’ have been entered (and the cursor is no 
longer in 'Number of warp ends), the outcome of this calculation will show up in the 'Width (cm)' and will 
be recalculated taking into account weaving and washing shrinkage. This applies analogously for 'Number 
of picks' to 'Length (cm)'. The recalculation may lead to an approximation that may cause the entered 
value to deviate slightly. 



WinWeef 10.3 Manual 

 40 

By clicking 'To clipboard' WinWeef creates a text on the clipboard with [Tabs] in handy positions. This text 
can be pasted into a Word document. Combined with an image of the draft, the design can be 
documented. 
 

 
 
Usually different colors are used in weaving. WinWeef can calculate how much material is needed for 
each color.  
Check 'Calculate 1 color' to perform the calculations per color. The WinWeef color palette with all colors 
used in the draft is shown. Click on a color and WinWeef indicates how many warp and / or weft threads 
of this color are present in the draft. All calculations are performed for this color. In this way, the amount of 
material can be calculated per color. 
Of course different materials can be used in a draft. These will also differ in color. By choosing a different 
color for each material, this screen can also calculate how much is needed for the different materials. In 
this case, after selecting a color, the warp material or weft material must also be changed. 
The calculation is also saved with the draft. If the calculation is done per color, the result can still be 
copied to Word. See Draft in Word. 
 
The tab Material allows the materials to be captured when it is likely that they will be used again.  
 
With the button 'New' an empty line is added at the bottom of the list. The selected line is deleted with the 
'Delete' button.This list is recorded in file WinWeefMaterial.tab. 
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Determine number of bars 
When weaving with a mechanical dobby loom, the correct number of bars must be made with the pegs in 
the correct holes to operate the shafts. While weaving it is necessary to know how many bars to go back 
or forward to get the right bar for the next weft.  
'Determine number of bars' calculates how many different types of wefts there are, how often they occur 
and what the greatest distance is that a certain bar is away from a previous bar, how often this largest 
distance occurs and for which pick that is the first time. If the bars are in a continuous belt, they can be 
turned back and forth and the largest distance will therefore be halved immediately. 
 
By removing a bar by pressing the buttons with the arrows, the greatest mutual distances can possibly be 
reduced. Because the numbers no longer increase neatly from 1 due to the displacements, the numbering 
can be made neat again with the Renumber button. Sometimes adding a bar can also have a beneficial 
effect. WinWeef uses the selected bar to double and gives that new bar the same number, and adds an 
'a'. By adding an extra bar, all other distances increase again, so it is very difficult to make an ideal 
composition! 
 
On tab ‘Treadling’ at each weft is reported which bar is needed and how much further 
(positive values) or how much back (negative value) the belt must be turned to go to that next 
bar.  
 
Following is an example of both tabs and a doubling of a bar for this treadling:  
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Bar 4 has been doubled, it is now called 4a. WinWeef 
has determined that the best bar that can be duplicated 
is bar 2. This is therefore selected. If slats with a letter 
have been added, first click on Renumber to exit the 
window. 

The result in the treadling.  
The longest distance is now 1 or -1. 
Instead of 4 and -4. 

  
 
After calculating these bars, in Menu File, Print 'Bars' will appear under 'Information'. On the print, next to 
each weft, tiny bar numbers are mentioned, on both the print of the entire design or treadling only. 

Counting colors 
The use of color in threading and treadling can be consulted with 'Counting colors'.  
By default, all threads in the threading or treadling are selected, but this can be adjusted.  
It is indicated how many threads of that color are present in threading or treadling and which % of the total 
this is.  
This window can be printed. 

Number of heddles per shaft 
When the design is carried out and the warp is set up, the correct amount of heddles must be set up per 
shaft. The menu option 'Number of heddles per shaft' counts how many heddles are needed for which 
shafts.  
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By default, the number of heddles in the entire row is calculated. Entering a different value will 
immediately adjust the count.  
 
This window can be printed 

Longest float 
For certain applications, designs with long floats are not useful. With a large design, an unexpected large 
float can occur somewhere. The longest floats are looked up with the menu option 'Longest float'. The 
menu counts them and indicates where the first floats of that length are in the design.  
 
The WinWeef main window can still be used, so if the window of 'Longest float' also remains visible, the 
longest float can be looked up by using the indicated thread number from the threading and treadling. By 
moving the mouse over the design, the location of the cursor is displayed at the bottom of the WinWeef 
window. 
 

 
 

Description Means a float with the  

Warp front Warp thread lying on top 

Warp back Warp thread is behind the design 

Weft back Warp threads lying on top 

Weft front Warp threads lying behind the design. 

 
The average float shows how balanced the design is, because that is not clear from only mentioning of a 
longest float. 

Import picture 
In the analysis screen, a design can be drawn that is based on an image that may already be available as 
a picture on the internet, as a digital photo or as a scanned image. This is certainly possible if the 
WinWeef analysis screen is used for the design of a crochet or embroidery pattern. This only concerns the 
grid pattern that is laid over the image. Converting such an image into a weave draft will often result in a 
very complex design.  
 
In the window of 'Import picture', a picture to be opened in a JPG or BMP file can be read via the 'Browse' 
button. In analysis > import picture > browse > C: > WinWeef > afbeeldingen > click roos zwart wit. 
In the example below, the heart of the rose of 'Rose black white.jpg' has been read from the WinWeef 
folder 'pictures'. With a grid height and width of 5, neither too many nor too few cells are created in the 
analysis. If the grid is chosen too coarse, many thin lines will disappear from the drawing. Moving the grid 
a little back and forth with 'Move right' or 'Move down' makes little sense in a drawing without horizontal or 
vertical lines, because where at one moment a line falls nicely into a square, other lines fall just halfway 
two squares. 
 
At 'Convert colors' try the options 'Most used color', 'Central color per square' and 'Average color' one by 
one. This can always be restored with the button 'Undo’ that shows the original image.  
 
WinWeef tests 9 pixels from each square. Therefore, a square cannot be made smaller than 4 by 4:  
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1 pixel for the grid itself and 9 more pixels for testing. 'Most used color' then counts which color value 
occurs the most. 'Central color per square' takes the middle of the 9 pixels. 'Average color' adds the Red, 
Green and Blue value of the 9 pixels and averages them to a new color value.  
During the conversion, a progress bar is displayed at the top of the window that indicates how far the 
conversion is progressing. 
Original Most used color Central color per 

square 
Average color 

    
 
Now that there is only one color per square, it is comparable to a WinWeef design. But just as with a 
normal draft with, for example, colors in the threading, this does not yet indicate where a square is filled 
and where it is not filled. 
 

 
 
Moving the cursor over the converted drawing, shows in the screen at the right bottom, three light grey 
displayed color values for Red, Green and Blue indicating what the color value is and in the larger color 
square below that color is shown again. 
 
With a black / white drawing like this, a value can be conceived that serves as a limit to whether or not a 
square is considered filled. In this example, all light and dark shades of grey are considered a filled 
square. For example, the limit value for Red, Green and Blue value is 170, which means that if the color 
value for all three color values is less than or equal to 170, the square is filled. And because white has the 
value 255, 255, 255, white squares will not be considered filled. 
 
By clicking on 'Convert RGB' WinWeef calculates which squares will and will not be filled in the analysis. 
WinWeef reports for example: 
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There are 5399 filled squares in the analysis. 
In the analysis a rose appeared and the color palette that is filled with hundreds of shades of grey.  
 

 
 
If the picture 'flowers.jpg' is read in from the folder 'images', with grid height and width of 5 and with 
'Average color' a true image will be created, but with grid height and width of 9 only a colorful cloud 
remains about. 

BMP to liftplan  
Bitmap (BMP) to liftplan. When a liftplan is designed in another program, for example in Photoshop 
Elements, its BMP can be quickly imported to a liftplan in WinWeef.  
This option can be used with a picture that is available on the PC as a .BMP file. A maximum of 2000 
threads are filled with the image and with no more than the maximum allowed shafts, set in Menu 
Settings, Preferences, More, Max shafts. Every non-white pixel in the image becomes a shaft that must be 
lifted. With the picture on the left as an example, the liftplan is shown as on the right.  
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Techniques 
The options in the Techniques menu are for weavers with some experience. To obtain the best result with 
the tools available here, technical knowledge of weaving is required. In the document 'WinWeef in 
practice' the possibilities are demonstrated by means of examples and exercises. This manual will 
therefore only briefly explain the operation of these menus. 

Block substitution 
The block substitution screen first requires that a selection is made from the list of possible block 
substitutions. After the selection, any repeats are displayed.  
If a repeat is grey, it cannot be edited. If a repeat is black and white, changes can be made. In the repeat 
can also be drawn with [Shift] click and [Ctrl] [Alt] click (see WinWeef Shortcut keys).  
The square size of the repeats is the same as the square size on the WinWeef main screen.  
With many block substitutions, a choice can be made as to whether the technique should also be applied 
in treadling and tie-up.  
Applying the chosen block substitution is only possible after clicking the 'Apply' button. 

Crackle 

 

The repeat should preferably show an 
inverted letter V. If the height  
and / or width of the repeat is changed, 
any changes to the repeat will be 
ignored and a best-fitting inverted V will 
be redrawn in the repeat. 
 
 

Double Weave Blocks 

 

Only with a repeat height of 4, two repeats are 
suggested for both a filled and an empty square 
in the  
tie-up.  

 
In the repeat for the threading and treadling, any 
changes to the repeat are ignored and a diagonal 
is drawn again.  
 
The option 'Treadling too’ is checked by default 
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Huck blocks 

The tie repeat depends on the specified width. The possible widths are 6, 10, 14, 18, etcetera. The 
specified repeat width is therefore rounded to the first repeat width that is equal to or larger than the 
specified width. 
 

   
 
With Huck blocks, selection can be made between 'Make reverses uneven', 'Make all blocks uneven’ or 
'Do not make uneven'. 

Plain Weave groups 

There is only one fixed repeat, there is no adjustable height and / or width and there is also no application 
to tie-up or treadling. 

M’s and O’s 

The width of the repeat is adjustable and is rounded to the first even number bigger than or equal to the 
specified width. The repeat shows the effect on the threading. 
 

   
 
By default the option ‘Treadling too’ is not checked.  

Turned Twill 

The repeat is a diagonal by default, with ‘Point’ an inverted character V and with 'Rosepath' the inverted V 
is interrupted halfway by a front shaft. The size of the repeat depends on the selected height. The repeat 
can be changed. 
 
Repeat With Point With Rosepath 
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With square tie-ups of 4, 5, 6, 7 or 8 Turned satin selection is possible.. 
 

4*4 5*5 6*6 7*7 8*8 

   

  

 

 

 
 

 

Advancing Point 

The repeat preferably shows an inverted character V. 

Advancing 
The repeat preferably shows a diagonal. 

Threading tie shafts 
With 'Threading tie shafts' tie shafts are added on the front shafts in a draft. The number of shafts is 
standard 2 but can be increased or decreased. An empty column in the tie repeat means that on that spot 
there is always a pattern thread filled in, that has already been drawn in the threading. A filled square in 
the tie repeat indicates where a tie thread will be placed. A completely empty or a completely filled tie 
repeat is therefore not useful and in such a case the Apply button is disabled. 
 
A design with the tie repeat underneath The result 

 

 

 
 

Threading Network 
Threading network is discussed in depth in 'WinWeef in practice'. Threading network is applied to a high 
design line in the threading. Such a design can be drawn on, for example, 60 rows ('shafts') to ultimately 
lead to a design, for example, on 8, 12 or 16 shafts.  
It is probably needed to temporarily increase the maximum number of shafts in the Settings > Preferences 
> More > Max shafts menu to be able to draw a design line with that many shafts. 
 
Reducing the many rows of the design line can be done by digitizing or telescoping. With 'Desired shafts' 
is then indicated how many shafts should remain in the design.  
Digitizing squares on the first four rows lead, for example, to squares on the front shaft, squares on lines 5 
through 8 lead to squares on the second shaft, and so on. 
Telescoping to, for example 4 shafts, the squares on the rows 1, 5, 9 and 13 lead to a square on shaft 1 
and squares on the rows 2, 6, 10 and 14 lead to a square on shaft 2, etcetera. 
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The size of the network repeat can be changed, the content of the network repeat can be quickly removed 
with the 'Erase' button. In this repeat a line can be drawn with [Shift] click and with [Ctrl] [Alt] click a 
diagonal. In the network repeat each column gets only one filled square. 
 
The same technique applied to the design line in the threading can be applied to a design line in the 
treadling. This can be indicated with 'Treadling too'.  
A design line can lead to a too scattered image of the shafts. Stretching the design line first will make the 
design more regular. The amount of stretching can be specified with 'Stretch factor'. 
 
An example of a design line over 26 rows. 

  
 
 

 
 
The option ‘Show in between’ provides a step-by-step picture of the conversion from design line to 
threading network. 
 
The first step is reported with ‘Threading telescoped’.  

 
 
The second step is reported with ‘Networking is now in progress…’  

 
 
In this step no colors are shown, but the network repeat is shown in light grey, in dark grey the design line 
as changed by the choice at 'Distort design line’. The black squares indicate the result of the threading. 
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If the result is not satisfying, go back to the design line by menu Edit > Restore threading (or directly with 
the [F6] key). 

Designing Liftplan 
Designing Liftplan will be discussed in depth in 'WinWeef in practice'. 
The size of the squares, the number of columns and the number of rows are the same as the ones on 
WinWeef main window.  
Up to a maximum of 8 compact and 4 large repeats are possible. The height and width of the small 
repeats are all set at the same time and three repeats have a default content. The four large repeats can 
be set individually. Because of the size, each has its own 'Delete' button.  
 
The content of the repeats and the designed liftplan itself are saved with the design file. 
 
By clicking in a repeat, or by clicking its color square, or clicking the 'Fill' button, a thicker border is drawn 
around the color square to indicate that this repeat has the attention: 'the focus'.  
 
In the repeat can be drawn with click, [Shift] click and [Ctrl] [Alt] click (to make a diagonal). 
  
Blocks can be made with F2, or via Edit > Block Mode in the 8 compact and the 4 large repeats, enabling 
options for copy, paste, empty, mirror, turn, swap, horizontal swap, invert.  
In Edit it is possible to select 'Restore network', in order to undo a fulfilled block action during the building 
up of the liftplan.  
 
In Designing Liftplan, color lines in the liftplan indicate which areas will be filled by a particular repeat. 
Moving the pressed mouse through this liftplan, makes that the color of the repeat that has 'the focus' will 
be drawn.  
With [Shift] click a wide line of squares is made between the last drawn point and the current point.  
To distribute a repeat on the entire liftplan in one go, click the 'Fill' button for that desired repeat. 

 
 
 
 
 
 
 
 
 
 
 

Drawing width 4       Drawing width 4 
Not cropped             Cropped 
 
Indicate the width of the drawn line at 'Paintbrush', 'line width'. For example, if a line is 4 wide and less 
than four squares from the right side of the liftplan are drawn, the option ‘Crop’ at ‘Paintbrush’ makes that 
line narrower.  
If the squares that no longer fit on the right side are to be drawn on the left side, do not choose crop. 
 
By clicking 'Apply' the color lines are replaced by the repeats and the resulting liftplan is displayed in the 
WinWeef main window. 
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Designing Liftplan with two repeats  
The result 

  
 
If a pattern line in Liftplan has already been drawn in the WinWeef window, it can serve as a guide for 
drawing a color line for a particular repeat.  
Enable the button ‘Import’ in the window ‘Designing Liftplan’. After importing subsequently the liftplan, it 
will be shown as a black line of squares, but there is no repeat in the color black. These black squares are 
for support only.  
The buttons with 'Fill' have now been changed to buttons with 'Follow'. If a 'Follow' button is clicked in a 
repeat, WinWeef will follow the imported line with the set 'Line width' and with the setting at 'Crop'. That 
line will then disappear and so the 'Follow' buttons become 'Fill' buttons again. 
 
Pattern line in 
WinWeef 

Liftplan design 
after ‘Filling’ and 
‘Import 

Liftplan design 
after ‘Follow’ with 
width 4 and no 
crop 

Built up 
liftplan in 
WinWeef 

    
 
With the menu choice 'BMP to liftplan', a bitmap can be read into the treadling, as it is possible with the 
same choice in the Analysis menu. The number of columns and number of threads stay the same. 
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Treadling for tabby 
This will also be discussed in depth in ‘WinWeef in Practice’.  

   
 
With 'Treadling for tabby’, tabby wefts can be added in an existing treadling.  
If this means that more rows are needed, they will be added automatically.  
By default, a tabby weave weft is always added, then a weft from the already designed treadling, being a 
pattern thread, then again a tabby weft, and so on. 
 
In the options list 'Tabby ' select whether tabby weave wefts should be even and odd, or whether they 
should only be even or only odd. 
 
The tie-up is extended with 1 or 2 tabby treadles on the left. 
 
If 'Tabby color’ is checked, a special color for the tabby weave can be selected with a click on the color 
area behind it. Without this color, the tabby pick will take the color of the pattern pick. Optionally, the tabby 
wefts can be given a separate color afterwards via the right mouse menu in the treadling and then 'Color 
all threads on treadle'. 
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The option 'Summer and Winter tie-up' makes a special tie-up for this technique. 
 
Original treadling 1 tabby 

1 pattern weft, 
Odd only 

1 tabby 
1 pattern weft 
Starting with odd 

2 tabby 
2 pattern wefts 
Starting with odd 
Tabby color 

1 tabby 
1 pattern weft 
Starting with odd 
Tabby color 
Summer and 
Winter 

 

    

Threading echo 
Threading echo will be discussed in depth in 'WinWeef in practice'.  
An echo thread is a copy of the original thread, except that the shaft of the echo thread is always shifted a 
certain number of positions more up or down than the original thread. The echo thread can come to the 
left or right of the original thread.  
A set of echo threads forms a line, which is parallel to the pattern line, a few shafts up or down. The 
pattern line is a set of original threads. 
 
In the window 'Threading Echo', 'By how many shafts’ indicates how many shafts forward the echo should 
be placed. With a negative value, it is a number of shafts lower.  
The 'Number of echo ends' is 1 by default, but can be increased. 
With the option 'Positioning of echo' the echo ends can be placed to the left or right of the original. 
 

 

Original  threading 
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Echo 3 shafts 
higher (3),  
1 echo thread 
(blue), to the 
right of the 
original.  

 

Echo 3 shafts 
lower (-3),  
1 echo thread 
(blue), to the 
right of the 
original.  
 
 

 

 

 

Echo 3 shafts 
higher (3), 
2 echo threads 
(blue), to the left 
of the original.  
 

 

 

 

Echo 3 shafts 
lower (-3),  
1 echo thread 
(blue), to the 
right of the 
original, then  
echo 1 shaft 
higher (1),  
1 echo thread 
(green) to the 
left of the two 
previous.  
 

Name draft 
Name draft is another way to draw a threading or block profile. 
Only the (capital) letters of the entered text are converted to one of the shafts.  
The text ‘A secret message for my love leads with 4 shafts to:  
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Louët interface 
The Louët company makes looms and these looms can be operated electronically. A weaving program 
controls a box with which the desired shafts are activated as they are set in motion with a treadle. 
WinWeef is also suitable for this interface. 
 
 
When the 'Louët interface' window is opened, only once specify at 'COM port' and at 'Interface' which 
electronic Louët interface is used and how it is connected to the PC.  
A COM port is an outdated system, but it is simulated via the USB port. 
 
At 'Start pick' the first pick of the draft is entered and the option 'Cont. repeating' can be checked from the 
first to the last thread of the draft. When WinWeef is closed, it will remember on which end the interface 
was. The next time WinWeef is started and the same draft is used, the beginning end is set to the correct 
value to continue. 
 
By clicking 'Start' a signal is sent to the Louët interface for the pick. The shafts are lifted, the pick is woven, 
the weaver beats the reed, which gives a signal to the PC, so WinWeef knows that the next weft can be 
prepared.  
 
To repeat a pick, click 'Repeat'. To skip, click 'Skip'. To stop, click 'Stop'. Louët interface will stop the 
process after clicking ‘Stop’. 
 
During the exchange of signals with the Louët interface, 'Busy with' shows which shafts are being 
controlled and the history is stated in text below. On the main screen, the treadling follows the thread  
Louët interface is busy with, and, if possible, 10 threads ahead and 10 threads behind this position for the 
overview. In the treadling, a small black triangle indicates which thread the interface is working on.  
 
Ascending or descending can be woven from the starting pick. When there is no repeat and the last pick 
passed, the history will always show 'Done'. 
 
If the idea exists that the PC is not cooperating properly with the Louët interface, this can be tested by 
clicking the 'Test interface' or 'Test treadle' button. WinWeef will only continue when the interface reacts 
with a signal or when 'Stop' is clicked. If one of the two tests has been carried out, an extra option 
indicated in red has been added, namely 'Debug Louët communication'. If this option is checked, technical 
information is added to the history about which signals are sent and which are received. 
 
As with the Technique menu, treadling for tabby, a tabby can be added while weaving with the Louët 
interface. If 'Tabby’ is checked, it shows specify how many tabby picks should be added after a pattern 
pick. Choose whether only with all even shafts, or all odd shafts, or alternately every even and odd shaft 
should be used for a tabby weft. 
 
During weaving, all settings can be changed in the 'Louët interface' window. For example, wefts can be 
skipped, repeated again or a permanent repeat can be set for another part of the draft. 
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Saving for Louët Dobby 2.0 
 
Saving a draft for the Dobby 2.0: Menu Settings > Draft > Convert draft to Liftplan > Save as 
WIF file.  
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Help 
This chapter discusses the help function. 

Help- index 
Opens the entire help text. 

WinWeef 
The window lists the owner's name and the associated code.  
The version number is also shown. 
 

 
 
A demo version, has code 0. In this case the window will ask 'Do you want to enter your WinWeef 
registration code?'.  
After confirming this question, entering a name with accompanying code is possible, giving the use of all 
the possibilities offered by the full version of WinWeef. 
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WinWeef 10.3 shortcut keys 
Action Press Bl  Action Press Bl 

Analyze Ctrl A   Paste Ctrl V  

Threading block Ctrl B   Print Ctrl P  

Treadling block Ctrl Alt B   Scroll Ctrl R  

Copy block Ctrl C   Rotate  Ctrl T  

Block mode F2   Stretch selection Ctrl J  

Go to threading Ctrl G   Mirror Ctrl M  

Go to treadling Ctrl Alt G   Stretch Ctrl U  

Help F1   Repeat paste Ctrl H  

Restore tie-up F8   Stretch blocks +  

Restore threading F6   Stretch blocks F4   

Restore treadling F7   Shrink blocks -  

Invert Ctrl I   Shrink blocks F3   

Insert Ins   Horizontal scroll Ctrl D  

Change color Ctrl K   Delete/ Clear Del  

Cut  Ctrl X   Preferences Ctrl Q  

Empty  Ctrl L   Settings drawdown Ctrl W  

Go to analyze Ctrl Y   Save draft Ctrl S  

Go to clipboard F5   Save draft as Ctrl Alt S  

New design Ctrl N   Search draft Ctrl F  

Flip Ctrl E   Zoom Ctrl Z  

Load design Ctrl O   Zoom F10  

       

Drawing 

Click place thread 
[Shift] click draw line from last placed thread up to here 
[Ctrl][Alt] click (front shafts) draw diagonally to the upper-right 
[Ctrl][Alt] click (rear shafts) draw diagonally to the lower-right 
[Ctrl][Alt] click (left-hand treadles) draw diagonally to the lower-right 
[Ctrl][Alt] click (right-hand treadles) draw diagonally to the lower-left 
 
Color 

[Alt] click place thread in selected color 
[Alt][Shift] click draw line in selected color 
[Ctrl] click place thread in brush color 
[Shift][Ctrl] click draw line in brush color 
Click change Block to selected color 

Block mode 

Click select location for Block-insertion 
sleep highlight block 
[Shift] click expand or shrink block to designated size 

Tie-up 

Click draw box 
[Shift] click draw line of boxes from last placed box up to here  
[Ctrl][Alt] click (lower row) draw diagonally to the upper-right 
[Ctrl][Alt] click (upper row) draw diagonally to the lower-left 
[Ctrl][Alt] click (left column) draw diagonally to the lower-right 
[Ctrl][Alt] click (right column) draw diagonally to the upper-left 

 



WinWeef 10.3 Manual 

 59 

Appendix WinWeef and Word 
This appendix discusses how parts of WinWeef can be copied to Word. 

How to use WinWeef to quickly and precisely create an image? 
WinWeef10 has special facilities to create an image of the design immediately. The other parts of the 
WinWeef screen are not included in the image. 

1) Start Word and move the cursor to the position where the image of WinWeef should be.  
2) Switching between Word and WinWeef: via the taskbar at the bottom of the screen or with [Alt - 

Tab]  
3) With right mouse in WinWeef, choose 'to clipboard'. This can be done in the threading, tie up, and 

treadling, in the analysis screen and on the draft. Also with the key F5, the icon of the camera, or 
menu File – Draft to clipboard, will put the design on the Windows clipboard.  

4) In Word paste the image via menu Edit - Paste, or [Ctrl-V]. 
 
Edit the image in Word. Some options: 

1) With the right mouse click 'format image', tab Layout, indicate how and where the image should be 
placed in the text. Choose 'Frame' or 'Contour' to also place text to the left and / or right of the 
image. To move the image, it must have a place in text as 'Frame' or 'Contour'. 

2) To enlarge / reduce / move the image, drag the corners of the image with the mouse. 
3) Putting the Word document on Landscape (File Menu, Page Setup, Landscape), makes the image 

larger. 
4) For the advanced Word user: images can also be placed in the cells of a table. This way images 

can be easily placed next to each other. In this case, choose 'In text line'! 

WinWeef Settings for a good image 
Menu Settings - Preference  

• Number of numbers: 0. No numbering is shown  
• More - Color for the objects: White 

Another method to copy a WinWeef screen 
The method described above is most ideal for copying images from WinWeef of the complete draft, the 
complete threading or the complete treadling. However, sometimes only a part of the draft or even from 
another window has to be copied.  
 
In Windows, use [PrintScrn] for a 'print' of the entire screen. Use [Alt PrintScrn]  for a picture of only the 
active window (with the blue title bar). The picture will be placed on the Windows clipboard and can be 
pasted into any Windows package, for instance in Word, but also in Paint. The 'print' can then be edited in 
Paint. After that, it is possible to select the picture in Paint, copy and paste it in, for example, Word. Such 
a picture is also called a screenshot or screen dump. 

Draft in Word 
By clicking on 'To clipboard' in the Draft window (see Analysis – Calculate Draft) WinWeef creates a text 
on the clipboard with [Tabs] at convenient positions. This text can be pasted into a Word document. 
Combined with an image of the draft, the draft can be documented in this way.  
In Word it will look like this when ‘Display' was selected: 
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By making the correct tab stops on the ruler in Word, the draft is neatly formatted (note the use of decimal 
tabs to neatly align the numbers): 
 

 
 
If multiple colors are used, a separate calculation will be made for each color or material. Each calculation 
can be copied to Word in the same way so that an order list can be made. 



WinWeef 10.3 Manual 

 61 

Appendix WinWeef and Outlook 
This appendix discusses how drafts can be sent and received with Outlook. 

How to send a WinWeef draft with Outlook? 
For example, sending a WinWeef file as an attachment to an e-mail by:.  

1. Create an e-maill  
2. Select in the mail menu: Insert > Attachment ...  
3. Browse with 'Insert attachment ...' to the correct folder (so C:\WinWeef or a folder below it), click 

once on the draft file, click on ‘Attachment’.  
  
Or faster:  

1. Create an e-mail  
2. Open Explorer, browse to the correct folder (i.e. C:\WinWeef or a folder  below) 
3. Drag a file, with the mouse pressed, from the Explorer to the e-mail and if a 'plus' appears at the 

mouse cursor, 'drop' the attachment.  
 
Sending a draft to someone who does not have WinWeef, a .wf1 or .wf2 file is of no use to that person. 
When there is a different weaving program, send the draft as a .wif file. Or send an image of the draft in an 
e-mail.   
To make and send such an image, see chapter 'WinWeef and Word'.  

Receiving a WinWeef design with Outlook 
1. The design will arrive as a .wf1 or .wf2 attachment.  

Select in the mail File, 'Save attachments ...' > 'Browse ...'> to for example the folder C:\winweef or 
a folder underneath (see 'WinWeef and Explorer'), click 'Save'.  

2. Start WinWeef and read the file.  
 
Directly with WinWeef10: 
Double-click on the WinWeef file in the e-mail and WinWeef10 starts with the file already read.  
Always be careful with saving, because whenever simply saving an email attachment (whether it is Word, 
WinWeef or whatever) it is saved in a temporary folder that disappears as soon as the mail program is 
closed! 
So always use 'Save as ...' and then select a real directory (e.g. C:\Winweef or a folder below it)!  
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Appendix Information for experienced Windows users 
This chapter is especially useful for people who are interested in the way WinWeef files are organized on 
the computer. This information is not necessary for working with WinWeef. 

Windows and WinWeef files 
Files in Windows generally have an extension: the three symbols after the period.  
(If Windows does not show them and you want to see them: in the Explorer menu, select Tools, Folder 
Options, View tab and uncheck 'Hide extensions for known file types', click 'Apply to all folders', choose Yes 
and click OK). 
Well-known extensions are DOC or DOCX (Word documents) JPG and BMP (images) XLS or XLSX (Excel 
spreadsheet) TXT (Notepad document). Double-click on a file in the Explorer, or one click and then select 
Open via the right mouse, Windows will try to start a program that knows how to handle such a file. In 
Explorer via the Tools menu, Folder options, File types tab (wait until the searching flashlight is ready) find 
a long list of extensions with the corresponding file types.  
After installation WinWeef10, the extensions WF1 and WF2 (and WIF) now read: 'Open with WinWeef10.3'. 
So when double-click on a WinWeef file in the Explorer or on an Outlook attachment, WinWeef10 will start 
and read and display the indicated file. 

Folders with WinWeef files 
In a standard installation, WinWeef is installed in the C:\WinWeef folder. WinWeef10 installation also 
creates many subfolders to encourage to neatly store WinWeef files in the appropriate folder.  
It is strongly advisable to keep 'data' (ie the WinWeef files, the 'drafts') separate from the software by writing 
it in other folders. From the standpoint of making back-ups (back-up copies of all Word, WinWeef and other 
data) it is actually even better to keep the data on a different disk than where the programs are. Use 
Explorer to drag / move the entire 'tree' of WinWeef subfolders to a D: drive, for example.  
In Windows, when dragging to another disk, Windows will keep the original. If actually wanting to drag / 
move without everything being left behind on the old disk, keep the Shift button pressed while dragging.  
 
Click with the right mouse on the folder that must be moved, select Cut (the folder will then become 'pale'). 
With the mouse cursor go to the disk or folder where it must be moved to, click Paste with the right mouse.  
 

 
 
If the folders have been moved, the first time in WinWeef browse the menu File, 'Open draft…' to the D: 
drive to find all.  
Create new folders by clicking the icon with the folder with the asterisk in the 'Save draft' window (see 
image above). A folder is immediately created, called 'New folder'. Type the desired name and then  
[Return]. With the button 'Open' that folder will be opened and the draft will be saved in that folder.  
Manage with a right mouse click on a folder or draft in the 'Save design' window, the folders and drafts. 
Delete pointless, empty folders and worthless attempts. 
In the Windows Manual, find out more about creating, moving, sorting, selecting, copying, deleting, 
renaming, navigating and searching through folders and files. 
  
Searching certain WinWeef drafts: WinWeef menu File > Search design. The title, number of shafts, 
number of treadles and any analysis are displayed there. With this information, and if desired, select 
'Delete'. 
Or: Menu File > Delete, where opening a file leads to its deletion. 

Working in more than one WinWeef window 
When closing WinWeef, all settings are saved in file WinWeef10.ini. If WinWeef10 has been started 
several times from the same folder, then the last WinWeef that is terminated will determine what is saved 
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as settings. Including the positions and sizes of the WinWeef windows and therefore also what the most 
recently opened files are.  
If this is not desired and if several WinWeef programs are regularly used at the same time, then install 
WinWeef again, but in a different folder and create a second shortcut. 
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Appendix WinWeef and languages 
In WinWeef10 Dutch, German and English can be found.  
Settings > Preferences > More > Language selection.  
 
Where do these choices come from and how can the translations be expanded or adjusted?  
 
The list of languages shown is created by searching in the folder where WinWeef is located for file names 
that start with WinWeefText and have the extension .ini.  
For example WinWeefTekstNederlands.ini.  
 
Adjusting the texts in such a file or creating an own variant, for example because another language is 
needed:  
For example, copy WinWeefTekstNederlands.ini to WinWeefTekst[OwnLanguage].ini. This file can then be 
opened and the texts can be translated in a simple word processor, such as Notepad.  
It is possible to edit such a file in Word (at File, Open ... and then at File type choose 'All files' or directly 
enter the correct file name at File), but at Save do not choose to save in Word formatting! 

Structure of a language file 
There are several sections in a settings file with the texts for WinWeef10. A section is identified by a name 
in square brackets, for example [Gen].  
The name of a section cannot be changed. In a section is a key and a value on each line. In WinWeef10 it 
was decided to define each key with a length of four characters. Between the key and its value is an =. For 
example scha = Shaft.  
A key may not be changed, so be careful with 'find and replace' actions!  
A value consists of the text that appears, for example, on a button, menu or message in WinWeef. 
If a & is used, for example mbew = Be&werken (Edit), this gives the option in a menu or on a button to 
make that choice with a letter key. The & may be moved or deleted.  
An @ in a text causes WinWeef10 to make a line break there. For example in  
wwv9 = The code is still from WinWeef 9. @ Now enter the code that matches WinWeef 10.  
This @ symbol is also completely free to use.  
The codes %d and %s indicate where WinWeef10 should insert a number ('digit') and text ('string') 
respectively. The order and number of these codes must remain the same in a text, otherwise WinWeef10 
cannot use the information. Example: tsch = Number of shafts is between %d and %d 
If help text is shown for a menu or button ('hint'), that help text will be after a | ('pipeline') set.  
For example mope = Open design | Read a saved draft in.  
The help text may be deleted if necessary.  
 
The changes can be viewed quickly: as soon as the settings file is saved and the language selection in 
WinWeef10 is briefly changed, all new texts are used immediately.  
 
The language selection can be found in the Settings > Preferences > More > select Language. 
  
It is possible to keep WinWeef10 and Notepad active at the same time to experiment with these changes. 
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About the Authors 
Kees Kraamer’s life changed significantly when, as a sophomore student in Biology, he came into 
contact with his very first (Apple) PC. He was immediately enthralled and on his own started to write 
programs, followed different trainings in the field of ICT, worked as a Software Engineer at Hiscom, iSOFT 
healthcare, DXC on hospital software for 31 years. At the moment he develops software at CompuGroup 
Medical for general practitioners and for paramedics at Convenient. In his spare time he has many 
different projects. 
 
During his study Biology, one of his first projects was developing a weaving program. His mother, Corrie 
Kraamer, an avid weaver, was always drawing her new weaving projects on graph paper with felt-tipped 
pens. Kees thought: it must be possible to do that on a computer! And so it happened. Thanks to their 
cooperation, the try-out became a useful program, WEEF – the precursor of WinWeef9 and WinWeef10.  
 
Marijke Dekkers became a textile teacher after her study at the Ns-training. She specialized in weaving 
and extended her knowledge by following different trainings in the Netherlands and abroad. 
Marijke was a weaving teacher for over 45 years. Besides that she gave workshops and lectures about 
weaving throughout the country. She is also a co-author of the National Basic Curriculum for Loom 
Weaving and very often she writes articles for the Dutch magazine WEVEN.  
 
At an exhibition in Delft, Corrie Kraamer demonstrated the program that Kees had developed for her. At the 
same time and place, Marijke Dekkers was demonstrating weaving. It turned out that Corrie had learned 
weaving at the Werkschuit in Gouda in 1975 and that Marijke had been a trainee at that place, while Kees 
often passed by after school, to meet his mother.  
Pretty soon Kees wanted to extend the possibilities of the program and Marijke offered to contribute at the 
further developing of the program with her specialized knowledge about network techniques, designs with 
tie shafts and block substitutes. This way WinWeef9 took shape, and it probably is the most used computer 
weaving program in the Netherlands. Marijke, Kees and Corrie gave many trainings at different places in 
the country. 
 
Marian Stubenitsky has been weaving ever since 1967. Her interest in woven structure theory was 
aroused from the very first weaving lesson. With a lot of practice and a lot of drawing on graph paper, she 
quickly understood how structures work and especially how to play with them in order to find new ones. In 
the mid-seventies she took the official Dutch course on Professional Weaving. From that time on she 
teaches weaving on location and at home in her own studio. Sometimes she participated in refresher 
courses and now she is one of the national and international top weavers.  . 
 
From the moment WinWeef was released, Marian has been enthusiastic about it. As a teacher, as editor of 
WEVEN and as a writer of weaving books, WinWeef was her best friend. She can read and write with the 
program and as a very critical teacher and weaver she naturally comes across things that she does not find 
useful or that could be improved. Through short communication lines with Kees Kraamer, over the years 
she has managed to realize many changes and expansions to WinWeef. 
Kees sometimes sighs deeply because she forces him to dive deep into the program again, but their 
collaboration has resulted in a professional, yet user-friendly design program. 
http://www.weefschool.nl  
 
WinWeef10 
Over the years, new wishes from users were constantly emerging and the technical possibilities expanded 
rapidly. Therefore Kees decided to build a complete new program, which would be called WinWeef10, 
again in cooperation with Marijke. However, they had not anticipated that the job would be so large and 
comprehensive. The new program was worked on for several years, often until late at night, it happened in 
addition to their daily work. The website www.winweef.nl was created to maintain awareness to the Internet 
and to offer updates from WinWeef. 
In 2008 we accelerated, asking the help of a group of weavers to test WinWeef, to edit the texts (Janneke 
Stelling) or translate (Loek Kraamer for German, Rachel Hardy for English). The result is in your hands 
now: 

- a complete new weaving program with numerous possibilities 

http://www.weefschool.nl/
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- a manual of Kees and Marlies Kraamer in which all the functions of WinWeef are systematically 
and extensively explained  

- an exercise book by Marijke Dekkers with which the weavers can get to know the possibilities of 
the program in practice. 

 
For many years, Marian Stubenitsky has been providing new ideas for WinWeef, including her needs for 
the creation of her books. Because of her worldwide clientele, it was decided in 2020 to also have the two 
manuals and help texts translated into English by Selma Sindram and Erik Ensing, and to release added 
extensions of WinWeef in an update WinWeef10.3. 

Site winweef.nl 
The site winweef.nl contains the new versions of WinWeef and all users will be notified by e-mail that a new 
version is ready there.  
 

http://winweef.nl/
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Index 
3D, 18, 33, 35 
alt click, 24 
analysis, 9, 15, 19, 25, 37, 38, 43, 58 
attachment, 60 
background color, 34 
backup, 36, 61 
bars, 41 
black and white, 34 
block, 14, 25 
block mode, 5, 14, 19 
block substitution, 36, 46 
BMP, 43 
brush color, 25 
calculation, 39 
change color, 25 
changes, 9 
clipboard, 13, 37, 40, 58 
code, 55 
color, 24, 42 
color palette, 6, 24, 25 
color range, 27 
cone, 39 
converting, 32 
copy, 14, 20 
crochet, 33, 43 
Ctrl-Z, 29, 37 
damask, 30 
default colors, 34 
demo, 55 
design line, 48 
diagonal, 6 
digitizing, 48 
distance, 41 
draft, 30, 39, 58 
draw, 19 
draw mode, 25 
drawdown, 5, 32, 38 
drawing, 6 
drawloom, 30 
duplicated, 26 
Dutch, 36, 63 
e-mail, 60 
embroidery, 43 
ends, 9 
English, 36, 63 
F10, 29, 37 
Fiberworks, 10 
floats, 43 
folders, 9 
German, 36, 63 
grid, 33 
heddles, 11, 42 
help text, 36 
hint, 5 
huck, 47 
image, 13, 43, 58 

information, 12 
insertion, 15, 26 
insertion point, 14, 15 
installation, 61 
interleave, 20 
JPG, 43 
lampas, 21 
language, 36, 63 
learning course, 28 
liftplan, 21, 30, 31, 32, 49 
line, 24 
loom, 30, 33, 39, 41, 53 
Louët, 53 
M’s and O’s, 47 
material, 33, 39, 40 
multiple pages, 37 
name, 30 
Notepad, 63 
number of digits, 34 
numbering, 5 
numbers, 12 
Outlook, 60, 61 
owner, 5, 12, 55 
pages, 12 
Paint, 58 
paste, 14 
pegs, 41 
permanent color, 25 
photo, 43 
pick, 9, 53 
picture, 43 
print, 11 
printer, 13 
ProWeave, 10 
quadruples, 22 
remove, 22 
remove color, 25 
repeat, 15 
restore, 20 
right click, 7 
right clicking, 19 
right mouse, 24, 25, 32 
right mouse click, 19 
rosepath, 30, 47 
rotating, 16 
ruler, 5, 13 
separate shafts, 21 
settings, 62 
shafts, 9, 30 
show in between, 49 
shrinkage, 39 
sinking shed, 29 
size, 6, 12 
slide, 14 
statusbar, 5 
stretching, 17 
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structure, 34 
subfolders, 61 
summer and winter, 52 
swapped, 16, 26 
symbols, 28 
tabby, 51, 54 
techniques, 46 
telescoping, 48 
text, 11 
thread, 12 
threading, 5, 6, 11, 18, 20, 26, 30, 38, 58 
threading echo, 52 
threading network, 48 
threads, 18, 26, 30 
tie-up, 5, 6, 30, 32, 36, 38 
title, 10 

toolbar, 5 
transparently, 21 
treadles, 9, 32 
treadling, 5, 6, 11, 18, 20, 26, 38, 58 
weaver, 12 
weaving magazines, 23 
WEEF, 56 
WF1, 9, 60, 61 
WF2, 9, 10, 36, 60, 61 
WIF, 9, 10, 28, 35, 37, 60, 61 
Windows, 13, 61 
WinWeef, 10 
WinWeef9, 56 
Word, 40, 58, 60, 61 
winweef.nl, 57 
zoom, 33 

 


